
Facilitation Suggestions
What We Learned about Facilitating a TechCamp Course

Facilitation Suggestions:

1. Preparation: Be prepared with your curriculum. This will help your mental state and
help the class go smoothly.

2. Timeliness: Start the session on time to show you care and you want them to have the
most amount of time possible. End the class on time. This works especially nice to give
you some free time to go over individual questions and allow participants to play with
what they are learning.

3. Introduction: Always introduce your self and the class, as well as the point: why is this
knowledge important for organizers?

4. Participation Interaction: Listening to instructions all class can be boring. Most of the
fun and enjoyable classes included some sort of interaction, group work, games and
collaboration.

5. Examples: The use of examples, games or personal stories is key to explaining a
complex, abstract or theoretical processes.

6. Presentation Skills and Speaking techniques:
1. Speak clearly and simply. TechCamp hosts people from many different

backgrounds and cultures.
2. Practice your facilitating with the tools (like lab computer) that you plan on

using.
3. Having fun and being enthusiastic will help participants not only be more

interested in what you have to say but also will help them learn by keeping them
engaged.

4. Try not to rush or go off on a tangent. It is hard to learn technology at a normal
speed.

5. Leave extra time at the end of class to practice and process the information.
6. Appearance: I know we are students and live in Santa Cruz but you will gain

more respect from the participants if you look the part.
7. Try your best not to hide behind the instructor's monitor or podium. Participants

need more personal integration to learn.
7. Expectations: Always expect surprises to occur in your class or course that might take

up more time.
8. Stay focused on the goals! Theres nothing like going off on a tangent and wasting 10

minutes of the class time. As a suggestion, send questions off to the other facilitators or
floaters in the room or volunteer to spend some time outside of class to discuss the
question. You may want to have another participant explain but only if it is a short
answer but two people talking in class is distracting.

9. Conclusion: Try to end with the import points to remember or take away from that class.
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Some excellent resources for presentations suggestions and examples are at Garr Reynolds'
website and blog : http://www.garrreynolds.com/Presentation/index.html
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What is a Facilitation Plan? The Basic Layout
Facilitation Plan:

Goals
1. Yours and what you would perceive to be theirs

Method
• PowerPoint, showing by example (live instruction), discussion, lecture, etc.

Materials Needed
• Computer, Handout, computer room, white board, etc.

Room Preparation
• Microphone, turning on all computers, passwords for each computer, lab attendee, etc.

Resources
• References to your facilitation outline: books, articles, websites, etc.

Facilitation Outline (This is the an in depth method or word for word instructions)
• This should include exactly how you plan on executing this course and how much time

you expect it to take. It may be helpful to write out word for word how you will teach
this course as well as practicing it in real time.

• Example Outline:
• Below
• For more samples review the past facilitation outlines in the manual

Facilitation Outline (Sample)

Introduction
• Self
• Goals
• Itinerary

Part I
•

Part II
•

Wrap-up: What did you learn?
• Reiterate goals

3



What Should a Handout Include?
• Handouts should be a supplement to the class.
• Something visual for the participants to take home and complete.
• An aid to later reference.
• Resources: Your sources and great online resources.
• Remember, community organizers don't have time to learn on their own, therefore, your

handout is a easy cheat sheet/guide.

4



Community Organizing TechCamp 2006

Course Facilitation Plans and Outlines
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The Internet: Searching and Safety
Facilitator Christine Hill

Facilitation Plan:

Goals:
• Everyone should leave having learned a set of practical tools for finding information on

the Internet.
• As well as tips on how to remain safe and secure while using the Web.

Method:
• Computer lab with instructor station for examples
• Should last about 1 ½ hours

Materials Needed:
• Computer lab
• Laptop w/ projector
• Handouts
• White board
• Microphone if large lab

Room Preparation:
• All computers on and signed on, ready to use
• All computers have Firefox web browser
• Write on white board: session schedule, your goals, my goals, and a space for upcoming

VOC (although the voc. is in the handout).
• If there are not enough computers have partners share.

Resources:
• Searching General

• Entire web: http://www.google.com/
• Encyclopedia: http://wikipedia.com/
• US Gov Info: http://www.google.com/ig/usgov

• Maps
• Directions, Businesses, other info: http://maps.google.com/ ,

http://www.mapquest.com/
• Non-profit Related Info, News and Tutorials

• Non-profit tech information: http://techsoup.org/
• Non-profit tech/software reviews: http://idealware.org/

• Buying / Shopping
• Compare prices: http://froogle.google.com/
• Buy and Read Product Reviews: http://www.amazon.com/
• A little of everything: http://craigslist.com/

• Images and Media
• Image searching: http://images.google.com/
• Creative Commons Media: http://commons.wikimedia.org/wiki/Main_Page
• Video searching: http://video.google.com/ , http://www.youtube.com/

• Browsing Safely
• http://www.mozilla.org/security/#Tips_for_secure_browsing
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• Phishing: http://www.antiphishing.org/consumer_recs.html
• Google Safe Browsing Firefox Extension
• Welcome to the Web [http://www.teachingideas.co.uk/welcome/] - Best, easy,

and colorful what is the web and how to search site.
• What is the Internet? According to Wikipedia. Includes an in depth definition,

history, protocols, access and other information. [http://en.wikipedia.org/wiki/
Internet]

• Google Safe Browsing Firefox http://www.google.com/tools/firefox/
safebrowsing/index.html

• Materials Used
• Media: What is the Internet.ppt, Networking computers ppt. (Great for

presenters' knowledge or as resource for TechCamp webpage)
• Phishing: http://www.antiphishing.org/consumer_recs.html
• Avoiding Spyware: http://www.techsoup.org/learningcenter/software/

page4415.cfm

Facilitation Outline:

Introduction
• Hi, my name is Christine Hill, I will be covering the Internet: Searching and Safety.
• What are your goals for this session? (List on white board) (2 min.)
• My goals for this session are for you: (list on white board) (2 min.)

• To be able to search and find information on the Internet using:
• Google –the search engine for searching, getting maps, books, etc)
• Wikipedia -online encyclopedia
• Craigslist- community forum
• TechSoup, Idealware, etc

• To know how to protect one's PC while browsing the Internet.
• Security from Malware: Viruses, Spyware and Adware
• Cookies
• Annoyances and pop-ups

• Itinerary:
• We are going to cover:

• Web Browsers and Search Engines (5 min.)
• Search Together as a group (15-20 min)
• Search Scavenger Hunt! (30 min)
• Safety Tips
• Viruses and Protection
• Warnings
• Guide against Computer Viruses
• Cookies
• Wrap up: What did you learn?
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• Last Note: Before we start I would like to reiterate that these sessions use a peer to peer
strategy. Therefore, if you would like me to slow down or if you have any questions
please do not hesitate to ask. If you have something to add I welcome it.

Part I. Search Tools
Browser and Tools

• Opening Questions (2 min)
• Who searches the web?
• What do you use it for?

• Is anyone not familiar with this vocabulary? (write item on board) (2-3 min)
• What is a search engine?

• Directories (General Search): Yahoo
• Indexes (Search words in all pages and text): Google

• How does the Internet work?
• The Internet is a collection of electronic documents that are linked

together like a spider’s web. Other names for the Internet are World
Wide Web, web, net, and red.

• What is a web browser? What do we use it for?
• A software interface that brings information to you from the web.
• Some provide more security than others.

Web Browser buttons and Vocabulary
• Go to the Start button at the bottom left corner of your screen. (2 min)
• Scroll up menu to Internet
• Double click on the Internet browser Firefox.

• Firefox is free, easy to use and secure. Firefox offers a variety of benefits or
software extensions:

• Tabbed browsing,
• Extensions: Tool bar

• Is anyone not familiar with the browser buttons on the top bar? (5 min)
• If not familiar

• Click something on the web page or fire fox home page, click
something again.

• Now go Back a page
• Now go Forward a page

• Refresh the page with new information from the source server.
• Home is to go the Internet browsers home page or the one you’ve set

up.
• Bookmark: Under this pull down bar at the top you can save, or

bookmark the web pages you liked. You can even make large files. 30
sec.

• Notice the address box at the top of the page. This box hosts the URL or
web page that we are looking at.

• Look at search shortcuts in Firefox (Top Right of tool bar), notice the
big "G" if you click the G you can switch search engines. However,
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Google is by far the best search engine at this point in time. (Lead out of
Firefox/browser discussion into tools/searching)

• If you do not know what a button does you can hover the cursor or arrow over
the icon to see if there is a “tool tip” or the definition of the icon.

Exploring Search Tools (20min)
• First I would like to ask, what tool/sites you commonly use to find information on the

Internet.
• Take out your Internet Search and Safety handout and worksheet. We have created a

resource/tool list for Finding Information. (In binder)
• Now were going to navigate the Internet?

• Techsoup
• In the address box, type in the word www.google.com
• Now in the search box, type in technology nonprofits
• Click on Techsoup –some of you may not be aware of this incredible

technology resource, helping nonprofit groups with technology.
• Take a minute on this page. 3 mins
• Now make sure your at the Tech Soup home page
• Click the Learning Center
• Notice the side bar In Learning Center
• Click using the Internet
• Skim over the article list
• But now say you have specific questions
• Enter in the websites search box at the top right secure computers
• Skim to in Learning Center; see Secure Computing the Key Ingredients.

Double Click That’s what we’re going to learn next!
• Now go up to the top left tool bar that says File; Click
• Click new tab

• Wikipedia- a collaborative encyclopedia.
• Wikipedia is a great free resource of information.
• Remember: since it is collaborative it is not totally reliable but helpful

and provides a reference list.
• Since collaborative one can also sign in and become a member. Once

you have built a repertoire with the managing group you can also
manage pages and delete obscene or wrong information.

• Note the great feature that you can choose your language; however
know that the greatest supply of knowledge is in English.

• Type in the URL or address box: www.wikipedia.com
• Type in the wiki search window Internet, click Search
• Scroll down the page check out the history of different search engines,

challenges, links etc.
• Explain difference between buttons: go and search.

• Go is for linking to web page called Internet
• Search is for searching for the word “Internet” in all of the

pages and its relevancy. (Index search)
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• Search for something controversial: President G.W. Bush (5min)
(Careful this is fun but will use up time; not necessarily useful for
non-profit organization)

• Notice post at top: “Because of recent vandalism, editing of this
article by anonymous or newly registered users is currently
disabled.”

• Above George W. Bush click the discussion tab. Here you can
see what people are working on and the recent corrections made
to the article. You can even scroll down and see the vandalism.

• Click the History tab and see all of the corrections listed by date
and time.

• Wikimedia Commons: Wikipedia is part of a group of free collaborative
applications called Wikimedia.org.

• In the URL box, type: Wikimedia.org
• The most common are “Wikipedia,” “Wikitionary,”

“Wikiquote,” and “Wikimedia Commons.”
• Click “Wikimedia Commons”, which is the database of video, images,

and media files.
• Google

• Notice at top of search box there is a tool bar: web, images, video, new,
maps, more…these are all themed databases.

• Click Images: search for an image. It is the same for video
• This is useful for copying and pasting images for fliers etc.

• Click Maps
• Great for finding addresses or directions
• Look under search box, see Search the map, Find businesses

and get directions.
• Under find businesses you can get local bus. for the area you

are in or are going.
• Why is Google Maps better than Mapquest?
• Look to right side of screen: here you can decide to view the

map in map form, satellite view or both.
• Search your home town and click satellite, then hybrid.

Now you can use roads and visual features to learn
about where you are going.

• This is great for planning door to door campaigns or
solicitation.

• You can also save your locations as bookmarks if you have a
Google account. (Google is free, shows no advertisements, and
not necessary to have an email account).

• Now go back to the Google home page and click More. These
are all the different databases to search.

• Click Froogle (Froogle allows you to search for the cheapest item you
need on the web. It can be very useful for non-profits who have tight
budgets)
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• What does an community organizer need to buy but at a super
discounted rate?

• Type in the search box, computer.
• Notice that you can search for a computer being sold near you

by typing in a zip code, city or state.
• You can also sort the list by relevance, price or rating if you

click the down arrow in the sort by relevance box above the
prices.

• At the top you can see a shorter list with price ranges matching
brands and stores.

• Go to the Google More page again. Notice you can get alerts
from Google about the topics of your choice or search books,
scholarly papers, or even set up online calendars or online excel
sheets (use for organization, not exceptionally important
information) that your whole staff can view and add. Google
also offers a language translation of web pages.

• Search for Idealware -Provides candid consumer-reports-style reviews and
articles about software of interest to nonprofits. (If have time)

Search Scavenger Hunt!!! (30 - 45 min) (Handout in binder) (This might be best at end of
session due to time consumption)

• Play a search game. Go to your handout that says Internet Scavenger Hunt. These
questions are designed to be answered using the above links and search engines.

• Go ahead and keep track of how you found your answers and how fast it took you. Our
goal is to share how we are searching and learn better ways. (5 min)

• Questions: You have (30 MIN)(In handout)
• Go over a few questions, how did students find their results: What worked best? (15

min)
• Key words for Google
• Categorizing what you want to know first into what would be the best place to

look. We have done a little of that for you in the Tools/Resources Handout.

Part II. Protecting Your PC!
Introduction and Vocabulary

• Review written goals for this section.
• Vocabulary: What are some of the dangers or perceived dangers about using the

Internet? Go back to board and write these down.
• Malware: Virus, worms, Phishing scams, spam, adware and spyware, privacy

breaching?
• Can someone describe what a virus, spam, spyware is?
• Viruses, worms and Trojan horses are human made software programs created

specifically to damage your computer, network etc.
• Spam is irritating commercial email that clutters your mail box.

• Often spam includes attachments. Those attachments can be infested
with malware.
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• Cookies: a serial number that a web server places on your Internet browser for
you personally, that can be used to retrieve your records from their databases.
These records include personalizations.

• Marketers use this information to find out which products to push on
you.

• Cookies are good if used correctly!!
• Many organizations use “cookies” to track your movement on their site.
• Cookies are kept in a file called cookies in your browser.

• Just another NOTE: Microsoft software such as Windows tends to be more
susceptible to viruses, spyware, adware. That is because windows Internet
Explorer does not have as safe of security architecture as other browsers such as
Firefox. Also hackers whose goal is to infect as many people as possible often
pray on Windows security gaps.

Warning Signs of Viruses:
• Your computer starts running sluggishly.
• It shuts down unexpectedly or crashes frequently.
• It experiences memory problems or runs out of disc space.
• Unusual files or directories appear on your system.
• Strange messages appear on your screen.

Virus Prevention Guidelines (15 min) (From the TechSoup Site/article)
• Look in handout.
• (If you do not have time pick out a few to go over or explain.)

Google Safety Tool Bar
• Now let’s go ahead and down load a Google tool bar designed for security. This toolbar

is an extension that will alert you when a false group or insecure web page asks for
financial/personal information.

• Type in at the top search corner Google Safe Browsing for Firefox.
• Click INSTALL
• Agree and Install
• Restart browser

• Now let’s find some cookies!!!
• It’s best to configure your browser to only allow the cookies that are necessary.

It is not helpful to block all of the cookies. Use Firefox to block cookies not
from originating site.

• Click Tools>Options> Privacy>Cookies>Allow sites to set cookies>For the
originating site only.

Tools and Resource List:
• The tools and resource list in is the handout.

Notes For a Great Session:
• Do your very best to explain how to do something. Make it as verbal as possible because

it is really hard for people to watch you then do it on their own computer. (Ex: Move
your mouse to the top left tool bar and select the blue square symbol for a floppy disc.
That is the save button.)

• Write VOC on the board that people do not understand and ask for a definition from
group or use your own.
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• Enunciate clearly
• Ask for questions or comments. Participants will have varying levels of experience. Use

their knowledge or discoveries to enhance the class.
• Remember this is peer to peer, which means you are a peer and are sharing knowledge

with the participants.
• Always explain the why and why useful for organizers. Why it is important to use

Firefox? Etc. This gives participants reason to believe what you are teaching is necessary
and they should listen closely.
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Hardware Workshop: Demystify the machine!
From bare metal to a working computer in 2 hours.

Facilitator Adam Thompson

Facilitation Plan:

Goals:
1. Know the components of a computer:

• Names of components.
• What components do.
• What components look like.

2. Be able to disassemble and reassemble the computer.
3. Know how to complete isolated hardware tasks:

• Remove, replace the hard drive
• Upgrade/change RAM
• Swap/install CD/DVD drive
• Add/change expansion cards

Method:
• Hands-on computer time.
• Room with computers to take apart and put back together
• Powerpoint with images and descriptions of the different hardware pieces.

Materials Needed
• Screw drivers
• Anti static bands??
• Computers (all available: do inventory)
• Monitors (all available: do inventory)
• Power strips
• Laptop or projector to play PowerPoint
• TechCamp CD of open source tools
• Handouts for TechCamp Reader

• Computer/Hardware buying guide
• Glossary of Tech/Hardware terms
• PowerPoint with images of hardware (ie http://santacruzblues.net/giip/

hardware/)
Room Preparation:

• Assembled computers arranged around tables to provide enough space between teams.
• Intructors computer (assembled) at one end of room.
• Projector and Screen??

Resources:
1. Wikipedia: Computer Hardware http://en.wikipedia.org/wiki/Computer_Hardware
2. Ars System Guide: Ultimate Budget Box http://arstechnica.com/guides/buyer/

system-guide-200602.ars
3. Great PC and Hardware Terms/Definitionshttp://www.kulnisandco.com/terms.htm

14

http://fellows.giip.ucsc.edu/wiki/index.php?title=TechCamp_CD_of_open_source_tools&action=edit
http://fellows.giip.ucsc.edu/wiki/index.php/TechCamp_Reader
http://santacruzblues.net/giip/hardware/
http://santacruzblues.net/giip/hardware/
http://en.wikipedia.org/wiki/Computer_Hardware
http://arstechnica.com/guides/buyer/system-guide-200602.ars
http://arstechnica.com/guides/buyer/system-guide-200602.ars
http://www.kulnisandco.com/terms.htm


4. “Upgrading Your Hard Drive” http://www.dansdata.com/sbs27.htm
5. Hard Drive Update: (Looks good, but a lot of these talk about Norton Ghost…Anyone

know what that is?) http://harddriveupgrade.com
6. Hard Drive Upgrade/Install (I like this one best) http://www.helpwithpcs.com/

upgrading/install-hard-drive.htm
7. Hard Drive Install, Update, Reboot, Partitioning and Reconfiguring (I don’t know

enough about this to say if it is REALLY useful, but it seems to be)
http://www.directron.com/how.html

8. Wikipedia: External Hard Drive http://en.wikipedia.org/wiki/External_hard_drive
9. eHow: How to Decide Whether to Replace or Repair a Computer http://www.ehow.com/

how_9895_decide-whether-replace.html
Facilitation Outline:

1. Review the components and ask questions about PowerPoint with images and
descriptions of the different hardware pieces. (i.e. What is a Hard Drive? What is RAM
or Memory?).

1. Explain some basic cautions: static and memory.
2. Most likely students will need to be in groups (of 2). Provide each group with an

ASSEMBLED computer and screw driver.
3. Trainer walks through taking apart the computers explaining the parts:

• How to remove cover
• Remove expansion bay
• Removing floppy, zip, cd and hard drives
• Removing memory (RAM)
• Removing motherboard
• etc.

4. Trainees then put computers back together, attach monitor, attach power and test. (Prize
for first working computer??)

5. With time remaining: Have students complete common hardware tasks (ie swap
harddrive, add/change memory, etc.)
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OS Basics:
Getting to Know Your PC Operating System

Facilitator Shaeleya Miller

Facilitation Plan:

Goals:
• What is an Operating System? What does it do? What are common Operating Systems?
• Understanding the file system: What are files and folders/directories?
• Open, Edit, Rename, Delete and Save files
• Open, Browse, Create, Rename and Delete Folders
• What are file types and extensions?
• What are programs/applications?
• Navigating and MS Windows
• Accessing files from CD/DVD
• Copy/save/burn CDs or DVDs
• Keyboard shortcuts

Method:
• Guide the class through each step while showing them on overhead through instructor

computer.
• Interactive work groups or pairs in which participants go through process of saving files,

navigating the OS, etc.
• Encourage people to ask for assistance from a partner- (put people in pairs-

those with more experience with those who have less).
Materials Needed:

• A computer for at least every other person in the workshop
• Recent version of Microsoft Windows
• CDs to save to and to burn from

Room Setup:
• Computer lab
• Computer for every other student and updated version of Windows
• Screen for lap top or lab computer
• Handouts
• Microphone

Resources:
• Handouts with Keyboard Shortcuts and step-by-steps for certain things
• Links to helpful sites on handout

Facilitation Outline:

Introduction:
• Shaeleya
• Goals:
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• What is an Operating System? What does it do? What are common Operating
Systems?

• Understanding the file system: What are files and folders/directories?
• Knowing how to Open, Edit, Rename, Delete and Save files
• Knowing how to Open, Browse, Create, Rename and Delete Folders
• What are file types and extensions?
• What are programs/applications?
• Knowing how to navigate and MS Windows
• Knowing how to access files from CD/DVD
• Knowing how to copy/save/burn CDs or DVDs
• Knowing keyboard shortcuts

• Itinerary
• Introduction
• Part 1: What is an OS?
• Part 2: What is a program and an application?
• Part 3: Navigating MS Windows
• Part 4: Understanding the File System and Directories
• Part 5: Copy, Save, Delete Files, Folders and Documents
• Part 6: CDs and DVDs
• Wrap up: What did you learn? What can you take away from this?

PART I: What is an Operating System?
• Does anyone here know what an operating system is and what it does?
• Allow students to answer and evaluate what they say.
• Give a brief overview:

• "The operating system, which is sometimes abbreviated as 'OS' is the
software that manages all of the applications and programs on your
computer. The operating system is what makes it possible for your
computer to request information, open programs, search for and save
files within different applications and generally navigate your system.
In PCs the OS is often Microsoft Windows while Macintosh computers
sometimes use Macintosh OS. Also available are Linux and Unix,
which are open source Operating Systems (meaning the code is open for
others to alter and share...often for free), but since these are not as
commonly used in Community led organizations, we will be focusing
on Windows for the purpose of this training."

PART II: What is a Program and Application?
• We'll be talking a bit about programs and applications, but does anyone here know what

a program is?
• Programs:

• They help you to view and read files.
• Programs convert code to an easy to read format for you to easily

navigate.
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• Word is one example of a program. The Operating System is another
example of a program, but it is one that maintains on its own for the
most part, whereas Word requires user input to constantly tell it what to
do.

PART III: Navigating MS Windows (Properties, Desktop, Changing Default Settings)
• Now that we've covered the difference between programs and applications and the

Operating System, we should cover some basics of navigating MS Windows.

The Windows Explorer
• Windows Explorer allows you to browse through directories, files and folders using a

navigation program. In order to explain it, it is easier to show it. Lets start by using some
simple exercises that will familiarize ourselves with the Operating System.

Properties
• In order to make basic changes to your Desktop (the screen that shows by default when

your computer starts up) and how you view what's on your computer screen in general,
you need to go into the Property menu.

• Right click on an empty space on your desktop and select "Properties" in the menu that
comes up.

• This window is a part of Windows Explorer, the program built into the
Windows OS to help you navigate your computer. If you want to minimize a
Window (make it shrink to the bottom of your screen without closing it) do so
by clicking on the dash “-” at the top right corner of the Window-- the double
boxes will restore it to normal or, if there is only a single box it is already at a
"normal size" and will be maximized by clicking it...the “X” will close it
altogether.

• From here you can see the following menus: Themes, Desktop, Screen Saver,
Appearance and Settings.

• Any time you want to make a change to anything in the Properties menu, you
must click "Apply" or else it will not save your changes.

• Click on ''Themes'':
• This has a drop down menu in it called "Theme".
• If you click on the arrow of the drop-down menu, there are a variety of different

themes and colors that you can apply to your computer.
• Click on "Desktop":

• Here you can choose what your desktop background is by either selecting from
the list shown or by clicking "Browse" and searching your computer for image
files and selecting them.

• Notice that you can also select "None" if it is easier on your eyes, or you prefer
not to have an image background.

• Click on "Screen Saver":
• The drop-down menu gives you a list of optional screen savers.
• Some screen savers can run at different speeds, in which case you can click on

the "Settings" Button next to the screen saver drop-down menu. For now, we
will move on,...
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• Click on "Appearance":
• This menu is much more important... Have you ever noticed that navigation

windows in Explorer are sometimes difficult to read? In this menu, you can
adjust the size of Explorer Windows.

• You can also change the color and style of your Explorer theme, and under
effects, you can change more minor aesthetic details, but those are things that
you can explore more on your own.

• Click on "Settings":
• This menu allows you to adjust the overall resolution of your computer. The

HIGHER the resolution, the SMALLER the font and images (and the sharper
the detail). This will change the resolution of your monitor OVERALL. This
means that not only the Windows Explorer boxes will be enlarged, but your
Documents, Folders, Internet, Windows...
EVERYTHING will change.

• If it will make you more comfortable, adjust your resolution now and take a
minute to figure out what works for you. Play around with this menu a bit.

• Make sure to "Apply" before closing the Properties Navigator.
• Click the ''Advanced'' button near bottom of window.

• There is a slide scale for “frequency” which will adjust how quickly
your monitor refreshes. If your frequency is too low and you don’t have
an LCD monitor, it can make your head hurt and bother your eyes.

Task Manager
• This is important to know about if for some reason your computer freezes up while you

are working in an application. By using the ''Windows Task Manager,'' you can override
the program and tell it to "End Task" when you are unable to get it to recognize that you
are attempting to close it from within.

• Lets start by opening something up so that we can see it in the Task Manager.
• Go to the ''Start Menu'' in the bottom toolbar and select "Word". All you have to

do is open it...no need to do anything yet.
• Once it is open, on the keyboard press "Ctrl"+"Alt"+"Delete" at the same time. Do you

see that window that just popped up?
• The menus read: ''Applications,'' ''Processes,'' ''Performance,'' ''Networking'' and

''Users.''
• Look at ''Applications.'' (Processes can tell you which programs are taking up

what amount of your computers processing power, but is not necessary at this
point.)

• Click on ''Applications'' (it may already be showing) and you will see a
list of the programs running. Right now, ''Word'' is probably the only
one on your list.

• Under "Task" and under "Status" it should say "Running". If
the program was frozen, it would probably say "Not
Responding". In order to shut it down, you must click on the
program and then select "End Task". Try it now with Word.
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• This can get you out of a bind when there is no other way to exit a
program and your computer is crashing, but it is a last resort since you
can't save your work first.

PART IV: Understanding the File System and Directories
• "When saving files on your computer, it is important to know your way around your

Operating System. This ensures that, at a later date, you can find all of the information
that you found important enough to save in the first place. It is a very simple process that
can be complicated very easily. The first thing you need to know when saving files is
understanding the File and Directory Systems in your OS..."

• The Directory: "When you save a document, program or application, you save them to a
directory. Many Operating Systems call these directories "Folders". They are arranged
hierarchically beginning with the root folder, then the subfolder and the parent folder.
This might sound a bit confusing, but chances are, you'll recognize this layout when you
see it: (show picture of diagram of C:/ directory with branches to sub folder and parent
folder/directory i.e. applications, documents, etc.)

• The root directory is C:\
• Is the folder where all of your local files are stored on your computer.

All of the programs that you have stored on your computer will branch
out from this one. Lets all take a look at the one on the computers in
front of us....

• To access your directory, go to the ''START Menu'' bar on your
desktop. From there, go to ''My Computer.'' Do you see the window
with the C:\ E:\ and other directories?

• Chances are there is a picture of a CD next to one of them. This is the
CD-Rom drive. You can access CD files and burn them using this
directory, but we'll get back to that later. First, lets go into your Local
Directory (C:\).

• Double Click on the C:\ Icon. There should be a list of folders now in
the window. You are now looking at the contents of that directory. One
should be titled: "Program Files", another should say "Documents and
Settings." Often there are other folders/directories in your computer at
work or at home that are called "My Documents" or have specific
project names assigned to them.

• Creating folders to house your work in and giving them names that you
can remember will make organizing your information much easier. Go
ahead and browse through these folders for a few minutes and get
comfortable with the way the folder system is laid out. Go back a few
folders and forward a few. Then we will look at ways to save
documents and create files so that you don't have to search through
these too much in the future...

PART V: Open, Edit, Rename, Delete and Save Files, Folders and Documents
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• As I said before, creating folders to save your work in can make finding them at a later
date much easier and way less stressful. I'll show you how. To begin with, lets create a
document to save...

Creating and Saving Documents (And putting them places you will remember them)
• Go to the ''Start Menu''--> ''All Programs''--> ''Word''
• Once Word is done loading, type "Hello" onto the document.
• To save it, go to ''File''--> ''Save''

• In this window you can see here, that the box is called "Save As". This is
because you have not yet saved this document and need to give it a name and
place it in a folder. This is where many people go wrong- they simply click the
save button in this window without giving the document a memorable name or
placing it in a folder that they can remember later.

• Choose WHERE to save your Document
• On the top of this window, there is a drop down menu that has the name of the

directory that you are looking at. In this case, it is "My Documents".
• If you click on the arrow on the drop-down menu, you will see a list of directory

folders. These are all of the different places that you can save your information.
• If you bring the cursor down the menu, you can select another directory, but for

now lets just stay in this one.
• Along the side of this box, there are also icons that for larger directories and

locations in your computer.
• For example, see the one called "Desktop"? If you want to save

something so that it is on your computer screen desktop, you can click
on that and save it there, but that can lead to trouble...Anyone here have
a desktop that looks like this? (Show crowded desktop). This is why we
need to learn to create folders that are easy to navigate. You want your
file system to be clean and organized...and easy to access.

• In the larger portion of this window are listed the folders housed in the "My
Documents" Directory. If you already have a personal work folder created you
could save it in there by clicking on the folder and opening it, but since we don't
have a "Work" folder yet, lets create one...

• See the folder icons next to the drop-down directory menu? Put your arrow on
the one that has a star on it...Do you see the description box that pops up? It
should say "Create new folder". Click on it.

• Where it says Name:, type in "My Work" and then click "OK"
• Now, where it used to say "My Documents" it says "My Work" and

where there used to be a list of folders, now it is blank. That's because
this is a new folder with nothing inside of it. Any time you want to
create a new folder, you can do it from within a directory just like we
did now...So now lets continue saving our document.

• At the bottom of the dialog window, it says "File Name" next to a text
box. Inside of that text box, it should say "Hello". This is because files
automatically save a document as the first word or collection of words
in the text. Lets change the name.
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• Click on the box and delete the word "Hello" then type in "my first
document"

FILE TYPES and EXTENSIONS
• It is also important to save your document as the correct file type. This indicated which

format the document is saved in and ensures that information, styles and formatting are
not lost when you go back to retrieve it. For example, Notepad does not use formating
and text styles like Word, so if you save your document as a notepad text document you
will lose any bullet points, font styles or page settings you have chosen. In some cases,
where the person you are sharing a document with, does not have Word, it may be useful
to save it as a "Text" document or a "PDF" but in this case we want to keep it as "Word
Document".

• To do this, look underneath the File Name, there is another box called
"Document Type"...It should say "Word Document". If it doesn't, click on the
drop down arrow and select "Word Document". Sometimes, you will want to
save your work as different types of documents but not in this case. Once the
Document Type reads: "Word Document", Click on the "SAVE" Button.

How to Save Files in Different Formats
• You can save a file in a different format so that people can read it even if they don't have

the application you used to create it. Some formats also make it easier and quicker to
send a file via e-mail. You can also change the format of a picture so you can use it in
different applications. These instructions should work for different applications and
operating systems.

• Steps:
1. Open the file you want to change by double-clicking on it.
2. Click on File.
3. Click on Save As.
4. Type a new name for the file, if you want to rename it, in the "File name" box.
5. Hit the arrow next to the "Save as type" box and choose what format you want to save it

in.
6. Choose a location for the new file.
7. Click the Save button.
• Tips: The list of formats will vary depending on what kind of file you're trying to save

and the application you're using.
• If you're saving a resume so you can post it on the Internet, save it as a plain (or

ASCII) text file so it can be seen properly.
• Source: http://www.ehow.com/ehow/ehowPrintable.jsp?id=4960 [1]
• Its SAVED!!
• The box has disappeared and you are looking at your document again. The top

bar of your document should say "Hello". You have successfully saved your
first document for work. Yay!

• You should save your work early on...first thing even so that you know
you can find it later. Always save your work as you go as well. All you
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have to do is go to FILE--> SAVE and it will save your work from
where you are.

• So lets say you have been working on this document, and you want to
edit it, but you want to save the first draft as well. Go ahead and close
this document and I will show you how. Don't worry, we saved it
correctly and we will be able to find it quickly. Go to FILE-->CLOSE.

Retrieving Saved Work
• Okay, so now lets find that deocument. Go to START--> "My Documents", and find the

"My Work" Folder that we created. If "My Documents" isn't on your start menu, you can
go to "My Computer"--> "Documents and Settings"--> "My Documents".

• Do you see the "My Work" Folder?
• Open it up by either double-clicking on it or right clicking and scrolling down to

"Open"
• Look! Theres our "Work" Document...Double click on it and open it up
• Next to "Hello" type "This is the second draft"
• Before you do anything else, go to FILE--> SAVE AS (not SAVE, SAVE

AS)...This will allow you to save the edited document as a new document
• In the dialogue box where it says File Name: Hello, type in "Hello 2". After

making sure the document type is Word Document, click on "Save".
• Now, the top of your document should say "Hello 2". This means that you are

working in the edited draft, and the original draft is still saved as it was in
"Hello". Go ahead and check. Close this document and go back to your "My
Work" folder. Now you have two documents: "Hello" and "Hello 2". You can
go back and find them easily now.

• If all else fails and you don't see your saved file, if you remember the name, you can
click on "Search" icon in your Navigator and request a search for files with the name
you gave it.

Opening/Searching for a Document
• While you are in a word document, you can open another one by going to:

• FILE--> Open and clicking on the document you want to view. Lets try it
• Open "Hello" and then go to FILE--> OPEN.
• In the dialog box select "Hello 2" and click "Open". Now you have both

documents open in two different windows.
• Note: It is important to remember, however, that you will only be able to view

Word Documents in your directory when saving or opening from within the
Word program. Other program files will not be visible unless you search from
your OS directory (From either your local file directory or your My Documents
Folder). The same goes for PDFs (you will not be able to see anything but PDFs
if you try to open a file with Acrobat Reader) and any other application. The
only way to view ALL files regardless of type is through the Explorer, that is,
by searching from folders and directories instead of through programs. Folders
and directories, however, will be visible from any program search-- their
contents just might not be.

Renaming a Document, File Folder, etc.
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• All you have to do to rename a folder or document, is right click on it in the directory
and select "Rename". Lets try it with "Hello 2". How about we rename it, "Hello draft
2".

• Go to "My Work" and right click on "Hello 2" then select "Rename". See how
the name is highlighted? Type "Hello Draft 2" and press enter. Now it is
renamed. Its as simple as that.

Delete a folder, file or document
• Now lets delete "Hello", the first, unedited draft. To do this all we need to do is right

click it and, instead of selecting "rename" select "delete". Now it is gone
• This can be done for all files, folders or documents that you no longer need. You can

accomplish the same thing by simply selecting the file with your cursor and dragging it
to your recycle bin on your desktop. Lets try that with "Hello Draft 2".

• It is important that you know what to do if, god forbid, you accidentally delete a file,
folder or document. Lets say we actually wanted to keep our first draft, "Hello". Go
ahead and open your recycle bin by double-clicking on it or right clicking and selecting
"Open". When you open the recycle bin, you can see all of the deleted items and by
clicking on them and then pressing "Restore", it will return the deleted item to where it
came from. This works as long as you don't empty your recycle bin, so be sure that
before emptying it (which you should do every once in awhile to clear your storage) you
make sure there is nothing in there that you need to restore.

• Now that we have restored the document, lets go back to "My Work" and see if it is
there. If it is, then we have succeeded. Go ahead and play with those functions and
explore this area of the OS while we check in with those who need help or have
questions.

PART VI: CDs and DVDs (Saving, Burning and Accessing Files)

Accessing/Viewing Files from CD
• Lets say you have a CD and you want to access files that have been saved to that CD.

Lets insert our CDs into the CD Drive. (Show where it is) If your computer doesn't
automatically bring up a window asking you what you would like to do (i.e. "View
Files" or "Play in Real Player") you can get to the CD by going to "My Computer"-->
"CD-Drive"

• If you double click on the CD-Rom Drive you will be able to open it just like any other
directory or folder. Once it is open you can open any files on it and view them while the
CD is in the drive.

Burning and Copying Files FROM CD
• If you need to keep copies of the files from the CD on your computer one of three ways.

1. You can Right Click, and Select "Send To" then choose the area you want to send the
file to (i.e. "My Documents", but I don't think this is specific enough.

2. Instead, lets send it to our "My Work" Folder -- To do this, go to "My Documents"-->
"My Work" from the Start Menu so that the CD window is also open and visible. -- Now
that your "My Work" Folder is open so that you can see the contents, you can select as
many files as you like and "copy" them into your "My Work" folder. If you want to copy
one, simply right click--> Copy and then in the "My Work" Folder right click a blank
spot and select "Paste". Lets try that. -- If you want to move the ENTIRE contents of the
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CD to your computer, you can do this by selecting them all and copying and pasting
them as a group. Lets try it: --- Click on the Explorer window in an empty space at the
topmost part of the box and highlight all of the files on the CD by dragging the cursor
across them. Now right-click within the grey area and select "Copy". Notice that the files
are still on the CD as well as the file you have moved them to. That is because you are
actually copying the files to CD. Generally, this will be the case and you will not be
actually removing files from the hard disk.

• Go ahead and try it yourself if you haven't and I will walk around with the other
instructors and see how everyone is doing.

3. Dragging Files: Another easy way to copy files is simply to drag them. -- To do this,
click on the file and literally drag it to the "My Work" Folder by holding down the left
button and moving it over. This is the SIMPLEST way and will work in most cases.

Saving and Copying Files TO CD
• Now, if you want to SAVE a file to CD, it is a slightly different process. To do so, you

need a blank CD. Some CDs are re-writable, but most likely you will be using regular
CDs. This means that once you write the files to CD, you cannot add more. Lets all take
our blank CDs and insert them into the CD Drive. If a window does not automatically
open up with the option "View WRiteable CD FOlder" then go to it just as we did before
("My Computer"--> "CD-Rom"/"CD-Drive"

• Now that the CD is in, open the CD-Drive again and look at the empty explorer. Lets
save our "My Work" folder to CD.

• Open "My Documents" and right click on "My work". You can use the same three ways
of moving the files to the CD window as you did when you were copying files FROM
CD.

1. In this case, selecting "Send to" is specific enough, because the option "CD-Drive" is
visible and that is EXACTLY where we want to send it.

2. If you would like, you can also select copy--> then right-click on the blank window of
the CD drive and select paste.

3. Once again, the easiest way to move them over will be to drag them again (click on the
folder and move it to the CD window)

• So the files are in the CD window but we aren't done yet. These files are simply
WAITING to be written to CD.

• In order to WRITE (actually COPY and SAVE) this folder and it's contents to
CD, you have to do one more thing. See the icons along the side of the window?

• The first one should say "Write these files to CD". Click on it.
• When the CD Wizard opens, follow the instructions to completion. Give the CD

a name, and click "Next". It will start writing the files and, unless you click
"Cancel" will continue through and finalize the Save process. Now you have
your Work Folder saved on a hard-copy in case something happens to your
computer.

Conclusion/Wrap-up: What did you learn?
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Updating the OS and Cleaning up your Computer
Facilitator Shaeleya Miller

Facilitation Plan

Goals:
1. Knowing how to install and utilize security applications and protect information on the

OS
2. Understanding the Firewall and how to change Firewall Settings
3. Disabling Cookies
4. Updating the OS
5. Updating the Anti-Virus
6. Understanding good passwords
7. Not Opening unknown File Attachments
8. Using Mozilla Firefox and Thunderbird (more secure than Internet Explorer and

Outlook)
Method:

• Powerpoint presentation for overall information
• Interactive work groups or pairs in which participants go through tutorials- perhaps one

in which they install a security software and run a security check
• Note: Encourage people to ask for assistance from a partner- (put people in pairs- those

with more experience with those who have less).
Materials Needed:

1. A computer for at least every other person in the workshop
2. Recent version of Microsoft Windows
3. Access to Outlook for a quick review of that application
4. CDs to save to and to burn from

Room Setup:
1. Computer lab
2. All computers signed on and ready to use
3. McAffee and perhaps Norton?

Resources:
• Computer Maintenance Presentation also on the wiki: Media:Cmaintenance.ppt
• This is a PowerPoint on the Wiki about installing software and McCAfee from Eric:

Media:McCafee.ppt
• Microsoft Website on Security (http://www.microsoft.com/windowsxp/using/security/

internet/sp2_wfintro.mspx)

Facilitation Outline:

Introduction
1. Introduce self
2. Outline of Session/Itinerary
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3. Goals:

Part I: Types of Updates (Definitions)
1. Disk Cleanup:

• Frees up space on your computer by getting rid of programs that you done need
or use and provides a list of programs you may want to delete

• Temp Files
• Deleted Files in the Recycle Bin
• Web Page information that has saved to your computer but that you

don't use ("Cached web pages" that are saved when you browse and that
make those pages load faster until the cache gets full and it really slows
you down)

• Downloaded Program files temporarily stored to your hard disk
2. Disk Defragmenter

• When you store things in your computer it can become disorganized over time.
When programs are installed in your computer they often get broken up and
different pieces are stored in different places on your hard disk. This is called
"fragmentation". Fragmentation can slow your computer down but the Disk
Defragmenter arranges all of those files in blocks that are closer together --
instead of having to pull information from various different places.

• The Defragmenter can also keep a log of the programs you use most often and
store them in one place so that they start up more quickly.

3. Windows Update
• The Windows Update website will provide you with important information and

updates for your computer that will ensure that it runs smoothly as well as
keeping you updated on security issues and patches.

Part II: How to Run Them
You can run all of these updates in your Windows "Task Manager"

1. Disk Cleanup:
• Go to: ''Start''-->''Programs''-->''Accessories''-->''System

Tools''-->''Scheduled Tasks''
• Double Click on "Add Scheduled Tasks"
• Scroll Down to "Disk Cleanup" and Click "Next"
• In this screen, select "Weekly" so that it gets done regularly. Choose a time

when your computer is on but not in heavy use.
• Click "Finish" to complete the process.
• Follow the Same Process for "Windows Update"

2. For the Defragmenter, when you get to the "Add Task" window
• Click "Browse"-->''Documents and Settings''-->"Start

Menu"-->"Programs"--> ''Accessories"-->"System Tools"-->"Defragmenter"
• Click "Open" button at the bottom of the Window.
• Follow the same steps as you did before for scheduling this task
• These programs will start up automatically now, but you have to click "OK" to

make them run.
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• For the Disk Cleanup, you must select the C: drive and press ''OK''
• For the Defragmenter, select "Defragment"

Part III: Anti-Virus, Installing and Utilizing Security Applications
• Mcafee:
• To do a general scan: Open your anti-virus program and click on “Scan”
• Scanning a file or folder

• This is called an “On demand scan”, when you download something and scan it:
1. You do this by Right-clicking on it and selecting “Scan Now”

• Updating the virus definition:
• Right-click on Anti-virus icon and select “update now”

• Scheduled scanning? you can do this by following the step-by-step processes within
your Anti-virus to do it regularly

• The Windows OS Firewall
• What is it?

• The Firewall helps to protect your computer from potential security threats by
blocking unauthorized access from programs and computers. By using the
Windows OS Firewall you can decide which programs and users you want to
allow to access your network and which ones you don't. Lets take a look at it.

• Click Start--> Control Panel (Notice that you can also change appearance settings and
accessibility options from this menu-- just like the properties menu)

• Select the Security Center Icon
• Click on Manage Firewall Settings
• Settings: Your options here are:

1. On (firewall protection on with some exceptions)
2. On without allowing exceptions
3. Off (No firewall protection)

• It is best to keep your firewall ON but to allow certain selected exceptions. If you do not
allow exceptions, computers on your network may be unable to access information and
you may not be able to view or access things online.

• Exceptions
• Now that you have selected "On" in the "Manage Firewall Settings" window,

you should allow some exceptions
1. Click on the "Exceptions" tab and select programs you want to allow access to your

computer by clicking in the box next to the name. A check mark will appear in the box
once you have selected it. Also un-check any programs that you see checked that you do
not recognize or wish to allow access.

2. If you do not see a program on the list, you can select "Add Program" and browse for the
program you wish to add.

3. When you are finished setting up the Firewall Settings, click "OK"

Part IV: Deleting Cookies
• When you go to a Website, it drops "Cookies," that is, files and bits of information in

your computer. In order to maintain your computer security it is a good idea to block
certain websites from dropping cookies into your computer. You will learn more about
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how to do that in Internet Security, but you can DELETE those cookies from your
computer. Cookies are both good and bad. (If cookies are planted from sites that you
frequent often than this information will help your computer bring up the website faster
and easier. If the cookie is placed by a site that you have not visited than it can be bad. In
the Internet Search and Safety you will learn how to set the cookies on your browser to
only come from sites you visit.)

• Windows Task Manager Settings.
1. See the Internet Options Icon above the Firewall icon?
2. Click on it
3. In the "General" menu, under "Temporary Internet Files", there is a button that says

"Delete Cookies". If you click on this, it will delete all of the Cookies stored on your
computer.

Part V: Best Practices
• Good Passwords:
• Good passwords are ones that would not be easy for someone to guess (Taken from

Compass point: The Accidental Techie). They should also be 6-8 characters long....
• Good- Two words that don't usually go together
• Better- A made-up word (like one from your childhood, "----"), or an acronym for an

easily memorable phrase (i.e.: inacb- "I need a coffee break")
• Best- Add numbers and/or symbols to the word or acronym-- maybe the year that the

phrase or word became significant to you (i.e. 19inacb98-- in this case I set the year
around the acronym to make it even more difficult to guess)

• Remember to change your passwords occasionally-- more frequently for more private
information, etc. and when employees leave your organization to ensure security. Write
them down if need be so you can remember, but NOT in manuals and other easy to find
places-- keep it in ONE safe place that you can access if need be.

• Also, Don't give all passwords and privileges to all computers on the network- there are
server administrators and then other users (those users do not need to be able to access
all secured files, etc.)...

• Don't Open unknown File Attachments
• Just don't.
• If you are reading e-mails and you see an attachment that you weren't expecting---

EVEN if it is from someone you know-- Do NOT open it. Call them up first and make
sure it is from them. Some viruses go into user e-mail lists and send out copies of
themselves to everyone in the address book.

• When you are online and you are browsing the web, don't download a file, program or
application that you don't know anything about or that is not from a credible source.
Research it before you put it on your computer.

• Use Mozilla Firefox and Thunderbird
• You will learn more about this in Internet Security and E-mail, but just to give

you a quick review:
• Mozilla Firefox is a Web Browser like Internet Explorer but it is more secure than

Internet Explorer and reduces your risk of getting a computer virus or unwanted spyware
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• Thunderbird works the same way. It is the Mozilla alternative to the Microsoft Outlook
mail client and works just as well, with a more secure connection.

Wrap up: What did you learn?
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MS Word: “Survival” Guide
Facilitator: Hanomi Sutton

Facilitation Plan:

Goals:
• Proficiency in core use of word processing

• Understanding Menus
• Working with files (open, edit, rename, save, multiple documents)
• Formatting Text, Paragraphs and Pages
• Find and Replace text
• Lists, Tables, Graphics (images and word art)
• Spelling and Grammar
• Templates (custom and built-in)

• Create standard word processing documents (ie business formatted letter, flyer)
Methods:

• Using projector and computer to show step-by-step processes...
Materials Neededs:

• Room with computers per person.
• Facilitator's Projector and computer.
• Word on all computers.

Room Setup:
• All computers signed in and on.

Resources:
• Windows 2000 Tutorial (Florida Gulf Coast University) http://www.fgcu.edu/support/

office2000/word/index.html
• LearningElectric: Microsoft Word (videos) http://www.learningelectric.com/word.htm
• Learn That: Microsoft Word http://www.learnthat.com/courses/computer/word/
• Word Quiz http://www.internet4classrooms.com/msword_toolbar_quiz.html
• Internet-based Word Processing

• Writely, the Web Word Processor: Collaboratively create, share and publish
word processing documents. Http://writely.com

• Google Pages: Create easy HTML pages using a web browser.
Http://pages.google.com

Facilitation Outline:

Introduction:
• Self
• Goals
• Itinerary

• Toolbars
• Menus

Toolbars:

31

http://www.fgcu.edu/support/office2000/word/index.html
http://www.learningelectric.com/word.htm
http://www.learnthat.com/courses/computer/word/
http://www.internet4classrooms.com/msword_toolbar_quiz.html
http://writely.com/
http://pages.google.com/


• First, lets go over the buttons and toolbars.
• Note: The toolbars are shortcuts, we will discuss more options for each action in a bit.
• Before we start I would like to point out that if you do not know what an icon is you can

always hover with the mouse arrow over the button. If you wait a few seconds a box
with the description of the button should appear.

• Everyone take your mouse and hover over the icon that looks like a white piece
of paper.

• What does the box say?
• Now if you notice the other buttons next to the white icon. This is the standard toolbar.
• Standard Toolbar

• The icon that looks like a little blank piece of paper will create a new blank
document.

• Let's do that now.
• Click the paper icon.

• The little floppy disk icon will save your file with its current file name,
location, and format.

• Click save.
• Now a window will pop up that is asking you where you want to save

this document.
• Save the doc. to a place where you know you can find it later, today we

are putting our files in __________.
• The little folder will open an explorer window that lets you find the file you

would like to open
• lets re-open that file now

• Next we have the print button
• Don't click it, just know that this is the quickest way to send something

to the printer
• After that, we have print preview, which allows us to see how our document

will look
• Go ahead and click on this one. Now we have options for display,

layout, etc.
• Next is the spelling and grammar checking

• Let's type our names. For most of us, a little squiggly line appears under
our names. Now click the Spell Check. We can add the words to our
dictionary, skip temporarily, skip all instances, or change to the
suggested words. Cancel.

• Cut, Copy and Paste icons are next, which utilize the clipboard (an imaginary
temporary space that runs in the background)

• Double click your first name to select it.
• Click the cut button or the scissors icon. It's gone! but not really - its

just on the clipboard.
• Now put the cursor after your last name. Click the icon of the

clipboard. Paste! That chunk of text is still on the clipboard.
• Now, select your last name. Click the icon with two piece of paper.

Put the cursor after your first name, and click paste.
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• For those of us who have to type the same thing over and over
again, these can save a lot of time and effort.

• Also, the clipboard can be carried across documents, which
means you can use copy and paste on just about any Windows
program. However, sometimes the formatting doesn't carry
over.

• The paintbrush icon is the Format Painter.
• We will return to this once we go over text formatting.

• Undo/ Redo Arrows
• Click Undo, then Redo. See the little arrow? That lets you see all the

past actions, and lets you undo multiple steps. Same with redo.
• However, once you undo multiple actions, and then perform a

new one, you can no longer redo!
• Zoom

• %, fit to...
• http://www.internet4classrooms.com/msword_toolbar_quiz.html

• Formatting Toolbar
• The toolbar below the standard toolbar is the formatting toolbar.
• Styles

• Lets add a few more lines: some basic info, your position and name of
your company. Play around with different styles; by default it changes
the current line, but select as many lines as you would like to apply the
style to.

• Font
• Select text to apply font to. Pick your favorite. Their names are all

displayed in the drop-down box as they appear.
• Size
• Bold, Italic, Underline
• Color

• Alignment
• These options allow you to choose where the text goes, left margin,

center, right margin, or both margins
• Numbers and Bullets

• Click once to turn on, again to turn off
• You can combine them to make outlines

• If you don't want it to format, click 'undo'
• To go to the next tier, hit the tab button
• To go up a tier, hit shift+tab

• Borders
• Last, we have Background color and Highlighting

• Not really that usefull unless you have a great color printer
• http://www.internet4classrooms.com/msword_toolbar_format_quiz.htm

• Drawing Toolbar
• AutoShapes
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• Play around with all the options: basic shapes, callouts, arrows,
symbols...

• Line, Line with Arrow
• Connects items in the document

• Squares, Ovals
• Word Art

• Click button, select style, type text, select font
• Text Box:

• Use this to place captions near tables or drawings, or to set off
text at the beginning of a page. Click and draw the box after
making this selection.

• http://www.internet4classrooms.com/
msword_toolbar_drawing_quiz.htm

Menus:
• Across the top there are words, File, Edit etc. These are drop down menus. Click on File

and you will see a menu.
• File

• Basically everything we already know, just two things to note:
• New...: allows you to select a particular document style.
• Page Setup: Sets margins, paper size, orientation and other layout options

• Edit
• Two new things: Find and Replace
• Find: Searches for specified text in the active document
• Replace: Searches for and replaces specified text and formatting

• View
• Views:

• Normal: The default document view for most word processing tasks.
• Page Layout: An editing view that displays your document as it will

look when printed.
• Toolbars: Displays or hides toolbars. We have just scratched the surface!
• Ruler: Displays or hides horizontal and vertical rulers at the top and left side of

the document.
• Header and Footer: Adds or changes the text that is displayed at the top or

bottom of every page of the document
• Page numbers are later

• Full Screen: Hides most screen elements so you can see more of your document
• Zoom: Controls how large, or small, the current document appears on the

screen.
• Insert

• Page Break: This forces the cursor onto the next page, even if the text doesn't
go to the bottom of the previous one.

• Date and Time: Choose from several formats for displaying date, time, or both.
• Auto Text: Insert any of several pre-set text lines, helps with alignment and

other formatting techniques.
• Symbol: Insert a symbol from any standard font which includes symbols.
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• Footnote/Endnote: Place a footnote at the bottom of the page or the end of the
document.

• Picture: Insert pictures from clip art or a file. You can also insert auto shapes,
word art, or a chart.

• File: Insert a saved document into the active document at the cursor.
• Object: Insert an object such as clip art, word art, an equation or much more.

• Format
• Most of these we've seen, but there are a few formatting options for special

cases, like newsletters, such as Columns and Drop Case
• Change Case is also useful

• Type something in ALL CAPS, ON ACCIDENT????? It's ok.
• Tools

• Spelling: we have already seen this in action
• Language/ Thesaurus: helpful synonym suggestions
• AutoCorrect helps save you time with common spelling errors, you can specify

what you do or don't want corrected here
• Templates are great for mass letters and other things
• Everything else on this menu dives deeper into the complexities of Word,

unfortunately we can't touch on every topic today, but I encourage you all to
explore!

• Window
• When working with multiple documents, this menu allows you to switch

between them, or split the screen so you can see all at the same time
• Help

• Searching help
• Office Assistant

Wrap-up: What did you learn? What can you take away from this session?
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MS Word Intermediate
Facilitator: Suzi Grishpul

Facilitation Plan:

Goals
• Proficiency in extending and customizing word processing
• Customizing menus and toolbars in MS Word
• Using keyboard shortcuts
• Creating, saving and reusing styles
• Collaborating and tracking changes
• Other / Misc

• Exporting a PDF
• Exporting HTML
• Macros?

Method:
• Show and describe with instructors computer and projector at same time as participants.

Materials Needed
• TechCamp CD of open source tools

• PDFCreator easily creates PDFs from any Windows program. Use it like a
printer in Word or any other Windows application. [11]

• OpenOffice a FOSS alternative to MS Office
• Projector
• Microphone if large session
• Handouts for TechCamp Reader

• MS Word Shortcuts
Room Setup:

• All computers signed in and on.
Resources: (Same or similar to Survival Word)

• Windows 2000 Tutorial (Florida Gulf Coast University) http://www.fgcu.edu/support/
office2000/word/index.html

• LearningElectric: Microsoft Word (videos) http://www.learningelectric.com/word.htm
• Internet-based Word Processing

• Writely, the Web Word Processor: Collaboratively create, share and publish
word processing documents.

• Google Pages: Create easy HTML pages using a web browser.
• MS Online Templates http://office.microsoft.com/en-gb/templates/

CT011323741033.aspx

Facilitation Outline:

Introduction:
• Self
• Goals
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• Opening: This workshop is all about harnessing the power of Word and making it your
own.

• Itinerary
• Templates
• PDF
• Track Changes
• Keyboard Shortcuts
• Questions

Modifying Templates
• File Open
• Select desired template
• Change info accordingly
• File Save As, Name it

Saving for Web

PDF
• See a Preview
• Save as .htm

Track Changes
• Right-click on toolbar, select 'Reviewing'
• Type things
• Turn on TC
• Accept/Reject
• Comments

Keyboard Shortcuts

Time for specific questions

Wrap up: What did you learn?
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Survival Networking
Facilitators Miles Reed and Christine Hill

Facilitation Plan:

Goals:
• To understand the network setup and topography
• To build Ethernet (CAT5) cables (abbreviated workshop)
• To demo various router configurations (Netgear, Linksys, Cisco, etc)
• IP and hardware addresses
• To address reservation for servers (printers, file servers, email, web, etc)
• To understand NAT and Port forwarding
• To Set up and secure wireless
• To Troubleshoot network issues

Method:
• Discussion style with white board, projector or individual tools to build network.

Materials Needed:
• CAT5e cable
• RJ-45s
• Crimpers (2 from GIIP + from Miles)
• Routers (Adam has Netgear Wi-fi, Cisco Wi-fi, Netgear vpn)
• Computer/Monitor to connect to router and display config
• TechCamp CD of open source tools
• Handouts for TechCamp Reader
• Cable building instructions and handouts.
• Network trouble-shooting and assessment worksheets?

Room Setup and Needs:
• Conference room with access to Internet and plugs.
• Or walk through computer lab.
• White board or paper diagrams

Resources:
• TechSoup Learning Center: Networks http://www.techsoup.org/learningcenter/networks/

index.cfm

Facilitation Outline:

Introduction:
• Introduce self and others.
• Goals: Yours and theirs.
• Itinerary

Questions:
• Who uses a network? Wireless?
• What is the network used for?
• What are possible problems that you can or do have with your network?
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Does everyone know what a network is?
• Explain (via a diagram in handout) what a small office network looks like and does?

What are some ways use utilize a LAN?
• Putting together a LAN:
• Explain how to create a LAN (computers, router, switch, cables, wi-fi)

Do cable building workshop
• Explain CAT5e cable wiring
• Provide CAT5e components to small groups (crimper, CAT5e cable, RJ-45s)

Routers and Switches
• Show types of routers and switches
• What are common configuration issues with routers?
• Setup
• Address reservation
• Port forwarding
• Filtering
• etc

Wrap Up:
• What did you learn from this session?
• What can you take away?
• Evaluation
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MS Excel: “Survival” Guide
Facilitators: Suzi and Arif

Facilitation Plan:

Goals:
1. Create a basic spreadsheet
2. Utilize a few formulas
3. Link spreadsheets
4. Formatting for on and off screen

Method:
• Using a projector and computer show and describe how to use excel.

Materials Needed:
• Microphone
• White board
• Handouts
• Computers
• Projector

Room Preparation:
• Computer lab
• All computers need to be on, signed in and have excel loaded.
• Are there templates on every computer?
• Write goals and/or vocabulary on white board.

Resources:
• Tutorial: http://www.advanced-excel.com/
• Excellent Template Resource: http://office.microsoft.com/en-us/templates/

CT011356681033.aspx
• Online, Collaborative, Can export to/import from Excel: http://spreadsheets.google.com

Facilitation Outline:

Introduction:
• Self
• Goals for session
• Itinerary

• Terms
• Data Types
• Examples
• Making a Chart/List/Budget
• Wrap-up: What did you learn?

What is a Spreadsheet?
• Does anyone know what a spreadsheet is?

• A grid for holding information, can be used for formulas and functions, but
NOT to replace large scale databasing.
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• Allows us to temporarily manipulate and analyze information, sort, filter, THEN
export files into databases and other programs.

• Limitations of a spreadsheet:
• Lack of auditing and revision control. This makes it difficult to determine who

changed what and when. This can cause problems with regulatory compliance,
among other things.

• Lack of security. Generally, if one has permission to open a spreadsheet, one has
permission to modify any part of it. This, combined with the lack of auditing
above, can make easy for someone to commit fraud.

• Lack of concurrency. Unlike databases, spreadsheets typically allow only one
user to be making changes at any given time.

Terms:
• Sheets
• Columns
• Rows
• Cells
• Filter
• Sort
• Chart
• Others?

Data Types:
• Labels: alphanumerical, are as they appear
• Values: numerical, can be worked into calculations
• Formulas: manipulations of compiled values

Example 1:
(Have students type up example 1 data, as shown in my example)

1. Format, so we know where everything goes
• Title

• Increase Font
• Merge
• Center

• Set Up Borders
• Categories

• Bold Rows
• Center Category headings

• Set Up Numbers as Currency
• Format|Cells...

• Formulas...
• *note copy/pasting of formulas and how it knows what do to...sometimes
• For each item, month=>year
• For each category, sums
• Totals
• Linking bottom items

Making A Chart:
• Chart Wizard
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Sorting:
(Using example2 data, have students create a contact list.)

• Sorting first by last name, then by Zip Code
Filtering:

• Useful for scaling down large quantities of data
Page Setup:

Wrap-Up: What did you learn?
• How to make a chart, a budget and use formulas.
• What are the most important things you should take away from this session?
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How Email Works?
Facilitator Arif Mamdani

Facilitation Plan:

Goals:
• Participants will learn about how email works at the network level.
• Including concepts:

1. Email is just text.
2. Email server vs. email client.
3. Email transmission protocols - SMTP, POP, IMAP.

Method:
• Sit is circle or at benches inside or outside.
• Discussion style.
• Pass out candy for demonstration.

Room setup:
• None.
• If inside use a white board for acronyms.

Materials needed:
1. large bag(s) of candy - each person will need five or so pieces of candy for demo

Resources:
1. Reading email headers :http://www.stopspam.org/email/headers.html

Facilitation Outline:

Introduction:
• Goals:

• To learn how email works at the network level.
• To learn concepts and voc.

• Itinerary: If any.
• Has anyone has ever sent and received email?
• What is email?

• In a basic sense, email or text is handled in ways that aren't all that different
from regular mail. When you send a postcard, you stick in the mailbox, and
someone takes it to a post office where its sorted and sent off to another post
office closer to where the mail needs to go. In this manner, its handed from
postal center to postal center until it gets to your local post office where its
given to a mail carrier to deliver it to you. The difference is that with email, the
stuff that handed your mail from place to place is all electronic.

Email Demonstration:
• So let's send some email!
• Gather everyone around one or two tables.
• Give each person five or more pieces of candy which symbolize email messages.

• Make clear that they're not to be eaten, yet.
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• Describe each candy as an email message, and holding on to one bag of candy, now
empty, as a mail server that sends and receives email.

• Ask someone to send an email to another member of the group and take the
email(candy) from the volunteer sender and place it in the bag.

• Does anyone know what happens between computers when you hit the send button?
• (Describe SMTP):

• Simple Mail Transfer Protocol is the language that computers use to
send mail between computers that process email message - called mail
servers.

• So that's sending the mail. Now, how does it get from the mail server to your
desktop?

• Who was this message sent to? Okay, so you're sitting there at your computer, you hit
send and receive or whatever, and the email message from volunteer 1 comes into your
computer (take candy/message and give it to volunteer 2). Does anyone know what
protocol (a set of rules governing communication within and between computing
endpoints or servers) you're using when you download your email?

• Discussion of POP and IMAP:
• There are two protocols used for getting the mail from the mail server to

your desktop: POP and IMAP.
1. POP stands for Post Office Protocol, and generally speaking, if

you use it, you're actually using version 3 of the standard,
which is why you see it as POP3 in your mail program.

2. IMAP stands for Internet Message Access Protocol. It's newer
than the POP standard and has some benefits over the POP
approach to email.

• What's the difference? It's all about where the email is stored.
(Demonstrate each protocol with candy.)

• For POP:
• Ok, so you've got all your email on the server, you

download it to your computer (transfer candy/messages
to person's "desktop." e.g. Outlook) Great, so lets say
that you go home, and want to access your email. What
happens? (Hear answer.) Right, and thats the weakness
of POP. You can't access email everywhere, especially,
from different computers. You could choose the "leave
on server" option, but even that runs into problems
because of concerns about space, etc.

• So the alternative to that is called IMAP.
• What IMAP does it it keeps all your email on the

server, and you "download" a copy that is then kept in
sync with the server. So you can check your email from
anywhere. In fact, using webmail, you're likely using
IMAP through a website interface. Demo IMAP with
candy too.

Thunderbird Setup:
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• Everyone okay with all those terms? Good, now lets go and walk through setting up an
email program so you see where these terms actually come in, and what they mean for
setting up the email program.

• (Walk through account setup in Thunderbird, making sure to point out that the
settings won't really work because we're making them up, and that each email
program is slightly different - but that the language will remain pretty similar -
SMTP for sending, POP or IMAP for receiving.)

Wrap-up:
• What you should take away.

• SMTP = Sending protocol.
• POP, POP3 and IMAP = Receiving protocol.

• Questions?
• Eat Candy!
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Tips and Strategy to Managing Your INBOX:
Facilitator Arif Mandami

Facilitation Plan:

Goals:
1. ID problems with how most of us manage email
2. Review different strategies for better managing email:

• Folders: Specific folder usage strategies
• Filters/rules to move mail automatically
• Searching: Search tools

3. Human factors:
• Distraction
• Signal vs. noise/SPAM
• Solutions

Method:
• Interactive discussion and presentation style

Resources:
• A lot of this section is borrowed and inspired by the Inbox Zero series from 43 Folders:

http://www.43folders.com/2006/03/13/inbox-zero/ and http://www.lifehacker.com/
software/top/geek-to-live--empty-your-inbox-with-the-trusted-trio-182318.php

Materials Needed
1. Flip Chart
2. Tape
3. Projector

Room Setup:
• Computers on and signed in

Material Needs:

Facilitation Outline:

Introduction
• Self
• Goals
• Itinerary

Game:
1. Begin with a 5 minute writing exercise - "what, in your opinion is wrong with email,

what in your opnion is troubling about your relationship with email?"
2. Spend 10 minutes max asking for volunteers to share their thoughts on ONE of those

two questions, capture on FCP and post around room.
3. Summarize - so email has some limitations, but so do we in how we relate to and use it.

Let's get into some strategies for relieving that pain
Strategies:
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• Ask: "How many of you regularly keep more than:" (Show of hands for each)
1. 1000 messages in your inbox on any given day?
2. 500?
3. 100?
4. 50?
5. leave the office with 0 messages in your inbox, almost every day?

• So, this is a problem right? the stuff just piles up, things get lost, you keep things in your
inbox thinking it will keep them fresh, but really what happens is that as new mail comes
in, items you wanted to keep fresh get lost as they scroll off the screen. So what to do
about it?

First Strategy: Folders
• Folders are one of the first tools to master in making email work well for you.

How many folks know how to create folders in their email program?
Demonstrate on Outlook and Thunderbird

• Folders are a cornerstone to using email effectively, but just like a file cabinet
and an overflowing "to be filed" basket, the folders are only good if we use them
effectively.

• How many folks have folders with one or two messages in them, that were
created in a moment of good intention, and have since languished due to lack of
continued processing of email and proper filing?

Second Strategy: Filters
• So, what do we do about it? A couple of things. First, the technological answer: filters,

also called rules and probably some other things in other programs.
• The idea is pretty simple - you tell your email program to move messages based

on a set of criteria to a particular folder - or in some cases to perform a
particular action. Let's say you're on a listserve that's important for your work,
but not on a daily basis. You can easily create a rule that watches your inbox
and whenever a new message comes in from that list, automatically moves it to
a folder you've created for that list.

• Here's how to do it - demo in outlook and Thunderbird
Third Strategy: Searching

• Okay, so folders are good, but even so, folders can get large and cumbersome, so lets
talk about another tech tool to make your email life easier - searching. Every email
program has some sort of search feature built into it, right? Who's used the search
function in their mail program?

• Here are a few tips to make your searching better and easier:
1. Only search all folders if you don't know where something is. Often, we don't

search because it takes too long. try to restrict your searches to the folders where
a message is likely to be, rather than searching all mail folders. Searching your
inbox taking too long? Well, that's why you should keep fewer messages in
there in the first place.

2. Use a third party search tool like Google's desktop search (which also searches
email), one of the Thunderbird extensions for search, LookOut for Outlook, and
others. Basically, these utilities are all designed to do searching better than what
comes in your mail client. They all have their ups and downs, and none are a
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substitute for effective filing, but they can come in handy when you just know
you had a message about something, but can't find it.

• So those are the techno solutions that we all love to talk about, some of us to fiddle with.
And believe me, you can burn a lot of time trying that next new great thing that will fix
all your email problems forever. And you know what? none of them work without a
good mix of personal habit changes and a pretty fundamental change in our relationship
to our email.

• I'm proceeding here from a couple of fundamental assumptions:
1. Its YOUR inbox
2. Its your time
3. Not all email is equal
4. No one, no one really lives in Outlook/Eudora/thunderbird or any other email client.

That phrase should be eliminated from everyones vocabulary.
• so, from there, there's a bunch of things you can do to make your life with email better.

Suggestions:
1. Turn off all email received notifications. Remember the good old days when you had to

go and check to see if you'd received any new email - actually switch windows, or on
really old machines, close the program you were in and start a new one? Microsoft's
"advances" seem more like they were trying to deliberately create a tool to make us
crazy. First there was the "new mail" sound (Cue AOL's You've got Mail recording" ok,
so that wasn't microsoft, but I can see some of cringing at the bad memories. Fast
forward to today where not only does Outlook play a sound, but it also flashes a
notification in the corner of your screen - COME ON! No email is that important - if it
was, the person would call you. There is no reason that you need your concentration
interrupted like that, so turn that crap off, here's how (demo in Outlook), other programs
are similar, come see us later if you have questions about your program).

2. Along with that, stop checking email all the time. If you can - for example if you don't
manage tasks and/or calendar in Outlook - just close the program and only open it at
times scheduled for email. Really, you can do it. I promise nothing bad will happen.
Nothing too bad at least.

3. Learn to delete. "If the little voice says “You’re never going to answer this,” consider
listening. If the little voice is wrong, respond then and there, no exceptions." AND, if
you're presently at a point where you've got way too much email, do this: Create a new
folder called whatever you want - Old mail, cleaning house, whatever. Then go to your
inbox, select all messages, and dump them all in that folder. See what happens. I'm
willing to bet that after about a week, you won't go looking in that old mail folder again.

4. Email processing - scheduled time, and a clear process
• Schedule your email time at intervals that will work for you. Maybe its 20 minutes every

2 hours or something along those lines. What do you do in that 20 minutes?
• A solution that's gaining quite a bit of ground is the use of set of folders labelled Action,

Archive, and Hold. Here's how it works: You create three folders, Action, Archive, and
Hold. These folders can have subfolders if you need them to. When you process your
email, start at the top and work your way down and deal with every message. If a
message can be dealt with in 2 minutes or less, do it, and don't forget that brevity is best
with email. If the email requires action, but needs more time, it goes in the action folder,
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and its often a good idea to change the subject line of the message so that it tells you
what action you need to do regarding that message. Come to the hands-on dealing with
email session for details on how to do that. If the message doesn't require action on your
part, but needs to be saved, guess where it goes? The archive folder! Finally, there's
Hold. Use this folder for items that you'll need deal with over the next few days - for
example, tracking numbers for a shipment of laptops, a message that you're waiting on
someone else to do something for, etc.

• The key to the Action and Hold folders is that you need to refer back to these on a
regular basis and/or transition items from those messages to your task list.

Wrap Up:
• So there you go, a couple of tech tools, a couple of habit changes, and you're on the path

to a better relationship with email. Come to the hands-on session to get some practice
with all of these ideas.
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Intro to Structured Query Language (SQL)
Facilitator Adam Thompson

Facilitation Plan:

Goals:
• To help participants understand that SQL is not really complicated, just precise, and that

any search they perform in a database is really an SQL Query. Hopefully understanding
how SQL works will help players create better database searches.

Method:
• Presentation style
• PowerPoint
• Examples

Materials Needed:
1. Bingo Cards from Media:Sql_bingo.tar.gz on the GIIP Wiki site
2. Candy

Room Preparation:
1. Needs a projector for intructor's laptop

Resources:

Facilitation Outline:

Introduction:
• Goals
• Itinerary

• Distribute data sheets (one of each to each participant) and one or two bingo
cards to each participant.

• Read each queries and make sure everyone has enough time to understand the
right answers. Ask someone to provide all the acceptable answers to each query
before you go onto the next one.

• Hand out some SQL Cheat Sheets for future reference.
• Vocabulary: query, member id, etc.

What is SQL and How does it work?
• When I was in fifth grade or so we had to do an exercise where we instructed a

classmate to make a peanut butter sandwich, as part of a lesson on Robots. I thought
everyone did that, but maybe I was wrong. The whole thing was very funny because we
were telling the robot (kid)to put the knife in the jar before the jar was open. We also
learned about apple logo, which I know some people here also had to learn "the
programming game" where you tell the turtles to draw?

• The point is that SQL, or Structured Query Language (some people pronounce it sequel)
is a pretty simple language, but your database can only do what it is told. When it seems
to think for itself, that is because some human got in there and gave it ideas. When you
are searching in any database, what you are really doing is filling out a form that the
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database application translates into some form of SQL and uses to query the underlying
data of the database.

• If you have a command line interface to your database, you could just type in a query
yourself.

Queries:
1. Query One: SELECT member_id FROM member WHERE last_name="Mejia";

• The "member_id" is the unique number that the database uses to tell Gilberto Mejia, the
seventeen year youth activist, from Councilman Gilberto Mejia when you've got them
both in your database.

1. Query Two: SELECT member_id FROM member WHERE organizer="Adele"
AND election_district="31";

2. Query Three: SELECT last_name FROM member LEFT JOIN
action_member_map USING (member_id) LEFT JOIN action_team USING
(actionteam_id) WHERE action_team.name="Mobile Home Parks";

• The "map" lets the database map one member to multiple committees, and vice versa.
Let people puzzle this one out and answer each other. It only gets worse:

1. Query Four: SELECT last_name FROM member LEFT JOIN
action_member_map USING(member_id) LEFT JOIN action_team
USING(actionteam_id) WHERE action_team.name="At Home Infant Care";

• Sometimes you aren't sure who you are looking for and you need to eliminate some
listings that you know aren't the right one:

5. Query Five: SELECT member_id FROM member WHERE last_name =
"Mamdani" AND first_name NOT LIKE "Arif";

6. And the last query: #SELECT member_id FROM member LEFT JOIN
action_member_map USING (member_id) LEFT JOIN action_team USING
(actionteam_id) WHERE action_team.name = "Workplace Justice Project";

BINGO:
• By now someone should have called BINGO. If they didn't, you maybe goofed

somewhere because one of the six card templates will always win. The game is rigged
like that.

• Give out prizes/candy
Wrap-Up: What can you take away from this session?

• SQL is not hard to learn just scarry and maybe confusing.
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Graphics and Design Layout
Facilitator Hanami Sutton

Facilitation Plan:

Goals:
1. Basic photo manipulation
2. Basic pamphlet layout theory
3. Hands-on experience with layout
4. Hands-on experience with photoshop and basic photo manipulation

Materials Needed
• One computer for every 1-2 people
• Adobe Photoshop
• Adobe Indesign
• Firefox
• Projector with instructors computer

Room Preparation:
• Computer lab with computers on and signed in.

Method
1. Discussion style
2. See and Do model
3. Use examples of good and bad design
3. Put people in pairs for exercises

Resources
• Handouts

Facilitation Outline:

Introduction:
• Self
• Goals
• Itinerary

What are the different stages of the design process? (Diagram on whiteboard/chalkboard)
• Brainstorm ideas of process: first, second, third
• What is the message?
• How are you going to relay that message?

• Through words, pictures?
What are charecteristics of good designs? Or What makes a design good or bad?

• Write down responses
Class Critique

1. Look through good and bad web pages
2. Pass around organizations' brochures: critique good and bad
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Adobe Photoshop: Lets play with Photoshop!

Play with Text
• Fonts
• Resizing
• Color
• Solid or outline
• Justification/paragraph
• Spacing: between lines and bewteen letters

Play with Images
• Cropping
• Resizing
• Outline
• Color/BW Adjustment

Play with Layout
• Headers/titles
• Page consistency
• Text and Image balance
• Overall layout of whole publication (step back)

Wrap-Up: What can the class take away? Helpful hints for organizers.
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Websites: HTML and CSS
Facilitators Suzi Grishpul & Arif Mamdani

Facilitation Plan

Goals: Participants will gain an understanding of:
1. How websites work;
2. What a web browser, web server, dns server does;
3. How a web page gets from the server to the browser;
4. How webpages are created;
5. How to edit basic web pages using commonly used html tags;
6. How to use the Windows Explorer's built-in ftp client to upload web pages to a web

server.
Method:

Resources Materials Needed:
1. Markers
2. Tape
3. Flip Chart or white board

Room Setup and Needs:
Facilitation Outline:

Introduction:
• Self
• Your Goals
• Their Goals
• Itinerary

• What is a website?
• What is CSS?
• Why is HTML helpful?

What is a Website?
Start with a discussion of what makes up a website. Draw pictures and use arrows to explain the
flow of web pages from request to DNS server to browser to web server back to browser.

1. what's a web page (brief explanation of what HTML is)
2. what does the web browser do?
3. what's a web server?
4. how does a web page get from a web server to your computer (your domain name and

website are technically different and unrelated, DNS, what a dns server does)
How you actually create a website?
Find a web server where you'll store your web pages - probably not your ISP, lots of price and
service options

1. review how pages are created - HTML editors, Contribute, CMS, etc)
2. Review FTP - what it is, what it's used for, where it comes into this mix
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What is CSS?
Time permitting, consider a very brief explanation of what CSS is, though this could easily be
dropped Wrap-up: Review, why knowledge of html is helpful?

• WYSIWYG editors can produce crappy code, sometimes you can't fix what they break
in the editor itself so you're forced to go in and edit the code directly, maybe you need to
make a quick change and your consultant isn't around.
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Good Presentations with or without PowerPoint
Facilitator: Arif Mamdani

Facilitation Plan:

Goals:
1. Review aspects of presentations that work and do not work.
2. Create a list of criteria for a "good" presentation.
3. Understand how power point can fit into presentations.

Method:
• Discussion in computer lab

Resources:
• Video made by Arif of different presentations
• Presentation Zen: Garr Reynolds' great website on how to make killer presentations.

Also check out his blog. http://www.garrreynolds.com/Presentation/index.html
• You Tube is a great resource for finding video presentations.

Materials Needed:
• Projector
• Example videos on CD
• Speakers?
• White board?

Room Setup and Needs:
• Computers on and signed on, ready to use
• Video and audio capabilities
• All computers have PowerPoint if have time or desire to use

Facilitation Outline:

Introduction
• Arif
• Goals
• Itinerary

Does presentation technology matter?
• Much of the time, probably not. Unless you’re regularly doing presentations to large

groups, much of the time tools like PowerPoint aren’t going to be of much use to you.
So why are we including it here?

• It’s here because every time we ask folks about technologies that they want to use more
effectively, PowerPoint or presentation technology appears high on the list.

• I know you all know about power point, what it is, and have some sense of what it’s
used for.
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• The challenge is to figure out how to use it in a way that’s effective and that
enhances your mission.

• Since you’ve all seen bad PowerPoint perpetrated by PTP, let’s start with some other
examples.

What is an effective presentation?
• I'd like you to take a minute to think about a presentation you've seen that was really

effective.
• Share why the presentation was effective? What made it work? (Capture on FCP.)

What about one that wasn't effective?
• What about it made it an ineffective presentation? (Capture on FCP.)
• Great, so we've got a rough framework for what works and what doesn't, let's apply it to

some examples we can all critique together:"
Presentations as examples to critique:
(Start video segment, with short critique after each, refer back to lists, add items if necessary.
Find sources on You Tube and Garr Reynolds website, below)

1. Immortality Institute Video starts @3:23, end after two or three minutes
2. Gillian Kerr - giving effective PowerPoint presentation. from start to 2:20
3. Dick Hardt - just after start (skip intro) to 3:30
4. Ballmer - pretty much any section of it.
5. Lessig - beginning and play for 2 minutes

Discussion of critique
• So, not surprisingly, there's a sort of cottage industry related to trashing PowerPoint, and

for good reason.
• In a brilliant and rather scathing essay called the Cognitive Style of PowerPoint, Edward

Tufte conducts an analysis of how PowerPoint influences the "dumbing down" of
content.

• (Review some Tufte points, esp the analysis of the shuttle slide.)
• On the flip side, and maybe more helpful for our purposes, there's a blog called

presentation zen run by a guy named Garr Reynolds. (http://www.garrreynolds.com/
Presentation/index.html)

• (Review some pres. zen points.)
Wrap-up: Lessons learned

• Here are a couple of points to remember about PowerPoint:
1. Prepare!
2. Connect with the folks you're talking with and a big stress on with, not to or at
3. Remember that you're telling a story - have fun!
4. Be afraid of the dark - PowerPoint is supporting your presentation, it's not the

presentation. We understand each other through body language, facial
expressions, etc. (grab screen shots here of gates looking like burns - put burns
in there too, also Steve mugging while taking photo booth shots), so don't dim
the lights to a point where folks can't see you.

5. Ask yourself “will a PowerPoint help me communicate my message? Does it
say something visually that I can't with words?" and if you answer yes to that
question, then for every slide ask "how does this complement my script? Is it
necessary? Does it add to the message, or obscure it?"
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• Time for Q and A
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Case Study: Technology and Organizing?
Why and How?

Facilitator: Christina Roessler
Facilitation Plan:

Goals:
• use a interview format case study to ground TechCamp in some examples of how

community organizing is enhanced through careful and considered application of
technology.

Method:
• Christina open sessions, introduces panelists
• Panelists have a few minutes to introduce themselves/describe their organization
• Christina interviews panelists/panelists ask each other questions - aimed at drawing out

how each organization uses technology to support their organizing work in general and
that ideally also covers one specific example that illustrates how technology makes a
concrete difference in each organizations ability to move their agendas.

• Session closes with Q&A
Resources:

Materials Needed:

Room Setup:

Facilitation Outline?

NOTE: This was all the information I could find on this session. To find out more talk to
Christina or Arif with the Progressive Technology Project.
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Case Study: Funding your Technology
Presented by Eugene Chan

Facilitation Plan:

Goals:
• To gain an understanding of:

• Why technology needs to be funded in non-profits
• How you can fund your technology
• How funders assess technology requests

Method:
• Introduction to Eugene Chan author of chapter 11 of The Accidental Techie by Sue

Bennett called “Finding Funding for Technology.”
• Session closes with Q&A

Resources:
• Chapter 11 of The Accidental Techie by Sue Bennett called “Finding Funding for

Technology.”
Materials Needed:

• Microphone?
• Handout?
• PowerPoint?

Room Setup:
• Lecture or presentation style

Facilitation Outline?

NOTE: This was all the information I could find on this session. To find out more read The
Accidental Techie by Sue Bennett, Chapter 11, “Finding Funding for Technology” by Eugene
Chan.

Intro to Databases

Intro to database session

Goals:

· Review what a database is and isn’t
· Review steps in building/revising a database
· Review concrete assessment tools groups can use to build or revise their database
· Tell you what we think about learning more access/filemaker (Don’t)
· Why you should consider a hosted database
· Share options for hosted databases
· Share a general process of what it might look like to transition to a different database
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· Answer the questions you have about databases

1. What is a database?
Databases are:
· A means to store and share information: A database is a container and organizer

for information about your organization, your members, all of the “stuff” we keep
in our heads.

· Like an electronic address book or filing cabinet, but it can do more.
· An aide in making connection between people, issues and organizing activities.
· A database is usually two things: A program and a file. A database file created by

one program can usually be transferred to another program (this is called
importing or exporting data).

Examples of Databases
· DB: Access, FileMaker, Dbase, Paradox, Approach, MS Works
· Not DB: Outlook, Claris Organizer, Excel, Lotus 123, Quattro Pro, Word/

WordPerfect (these are PIM – Personal Information Managers????)
What databases do well
· Allows grouping of many records based on similarity; cross lists

2. What databases can do for community organizers?

Group: Californians for Justice is a statewide group organizing in California. They have 700
members and work with people of color, young people and the poor. CFJ’s members engage in
direct actions, base-building coalition and advocacy.

Goals: CFJ has worked against affirmative action and anti-immigration issues. For the next 5
years they are leading a statewide campaign to organize youth and parents for equity and racial
justice in public education.

Use of technology:

In order to carry out their electoral work CFJ has maintained a database of about 10,000 people
from whom they identify new leaders, volunteers and organizers throughout the state of
California. Through donation forms, volunteer sign-in sheets, event attendance forms CFJ tracks
everyone who attends their events for later outreach. They also use it to track funders’ and
individual donor funding areas and deadline information, and to access allies to be able t to do
fax broadcasting, email, etc.

Tracking allows CFJ to then query out important database reports. For instance, because they
code constituent involvement and record contact history when they did No on proposition 21 to
lower the age of youth offenders to receive adult punishment and 22 to define marriage as that
between a man and a woman only. Staff split the state in certain areas and each staff was able to
pull out information of folks who they had been in contact with in specific area.
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Explain: What we have learned from CFJ’s example and others is that database solutions can
provide effective support different areas of organizing. For instance:

· Membership development: Track who is participating in events to build leaders
· Mobilizing/Actions: Generate walk lists; create a call list to mobilize people

interested in a particular issue
· Research and analysis: Compile data on people and issues for analysis and

reporting
· Communications: Allow for email and fax broadcasts to media outlets

3. So how do you build a database?
· Tech lifecycle/database lifecycle

i. Who does what
ii. What are the different parts
iii. What’s involved in each section

4. Share database assessment/planning tool
5. What we think about learning more access/filemaker –

· Don’t, here’s why – more and more, we’re seeing that custom databases just don’t
meet the needs of community organizing because they can’t. MJS ran a software
company and he often talks about how they never wrote software for themselves, even
though they had a staff of software developers – its just too expensive to get what you
really want, and even then, what you do get doesn’t meet your needs for very long.
Also a labor intensive/time intensive task to maintain and ensure the proper functioning
of the database/data.

· So, what do you do? Consider a hosted database – Define what a hosted database is,
share examples, why they’re good, where they’re lacking:

i. Databank
ii. Salesforce
iii. Basebuilder

· Process for transitioning – setup, data migration, training, training, training, AND shift
from “why can’t our one database do everything” to “which of the various tools is right
for this job: labels? Excel, word, mail merge; email blast – constant contact,
mailchimp, etc.”

MS Publisher: “Survival” Guide

Facilitators: Christine

Facilitation Plan:
Goals:

1. Learn VOC/Concepts of MS Publisher
2. Basic skills

§ How to Add Text
§ Inserting a picture into the text
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§ Resizing an image
§ Making the text flow around an image
§ How to print
§ MORE

3. How to create master pages
§ How to create your own idenity

4. Make Changes to Templates
Method:

• Using a projector and computer show and describe how to use excel.
Materials Needed:

• Microphone
• White board
• Handouts
• Computers
• Projector
• REMEMBER: Different versions may vary; the methods I'm showing are specific to

Publisher 2003
Room Preparation:

• Computer lab
• All computers need to be on, signed in and have excel loaded.
• Are there templates on every computer?
• Write goals and/or vocabulary on white board.

Resources:
• Christine and Jack’s facilitation outline on the use of images with MS Word and MS

Publisher from COaTI, CO 2006 – 07.
Facilitation Outline:
How many people here have used MS Publisher before?

• ???
What do you use MS Publisher for? Or what do you want to use it for?

• ????
• Flyers
• Brochures
• Newsletters

Word vs Publisher
• Word is a word processor designed to make/edit content
• Publisher:

• is designed to produce documents for marketing: b. cards, brochures, cards,
newsletters etc.

• Everything in a Publisher publication, including a block of text, is an
independent element. You can place each element exactly where you want it,
and you can control its size, shape, and appearance.

Introduction:
• (Set context for why these tools are good to know)
• State purpose of session:
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• To illustrate what's possible with the publisher tool that everyone has easy
access to.

• To learn how to create and/or make changes to publications/templates fast and
easily

Goals:
· Basic skills

§ How to Add Text
§ Inserting a picture into the text
§ Resizing an image
§ Making the text flow around an image

• How to create master pages
§ How to create your own idenity
§ How to print

· Making changes to templates
Groups’ Goals:

• ?????
Part I. Publisher VOC:

• Menus are the same as in MS Word although there are slight differences
• Frames/Placeholders
• Objects Toolbar: On left side; View menu>Toolbars>Objects TB
• Task Pane Toolbar: On left side dropdown; View menu>Toolbars> Task Pane
•

Part II. Basic Skills
How to Add Text

• Select the Text Tool and draw a Text Box on your page (also, Insert > Text Box
• Insert the text by:

• clicking in the text box you drew and typing directly into Publisher (convenient,
but can be a pain for text editing)

• typing your text up in Notepad, Word or another text editor or word processor,
then copying and pasting into your text box

• You can also directly insert a Word document into Publisher (Insert > Object,
Create from File, browse to the document you want to insert)

Formatting Text
• Select the text box that you want to edit, and the text formatting bar will appear or

become available.
• You can then change font face, style, size, alignment, line spacing, list types, and text

color just like in Word or other rich text processors by highlighting the text that you
wish to change. You can also change the background color within the text box, add
borders, and rotate the text box.

• You can resize text boxes by moving your mouse pointer to the markers on the edges of
the boxes until the arrow changes to two arrows, then clicking and dragging until the box
is the shape that you want. This will change the behavior of your text and how much
text you can fit within the page, so after you do it, make sure that all the text still fits.
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The "A..." icon indicates that the box includes text that does not fit within it (and that
you therefore cannot see.)

• To move a text box, move the mouse to the edge of the box until the cursor changes to
crosshairs, then click and drag the box to the desired position.

• To rotate, click on the green circle on the extended line (the rotate mouse cursor will
appear) and rotate to the desired angle.

Configuring Page Margins
• Unlike in Word in order to change page margins we don’t go to page setup under File

but …
• Arrange>Layout Guides>Margin Guides

Guides: (Make guides for Newsletter as example or whatever class wants to make)
• Grid Guides: Grid Guides are only visual guides for the designer.
• Base Guides: Base Guides will actually direct text within guide and make margins

around the guide
• They are used to create a grid on a master page. This grid appears on every page in your

publication where that master page is used. Use layout guides to organize text, pictures,
and other objects into columns and rows so that your publication will have an ordered,
consistent look. They are used to create a grid on a master page. This grid appears on
every page in your publication where that master page is used. Use layout guides to
organize text, pictures, and other objects into columns and rows so that your publication
will have an ordered, consistent look.

Flowing Text between Boxes
• Select the text box from which you want to flow the text, then click on the "Create Text

Box Link" icon (looks like a chain link) on the toolbar. The mouse cursor will change to
a little pitcher.

• Click on the text box that you want the overflow text to flow into - this can be on the
same page or another page. When you do, the text will automatically flow into the
chosen box.

• If you add more text in the first box, the text will shift down and flow into the next box
automatically.

Insert Design Gallery Object
• Design Gallery Objects are templates for objects within a document; just fill in with your

own information.
• Examples: Master header, Table of Contents, Coupons, Calendars, Quotes
• To Insert click lowest box on left. Now we can pick object by category, design, or

choose your own object like a logo you had made and saved etc.
Inserting, Moving and Resizing an Image/object

• On the menu bar, click Insert > Picture > From File
• In the Insert Picture box that appears, browse until you find your file.
• Click OK and the picture will appear in the file.
• Demonstrate how to resize, rotate and move the graphic, including resizing in proportion

and out of proportion.
Image Options: Changing the Picture color (If time)

• Under image toolbar
• Change Image to grey scale
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• Washout and enlarge for back drop by using the contrast and light buttons.
Making Text Flow around an Image

• Move the image into the text box that you want to use.
• Right click the image, then click "Format Picture" on the menu.
• Click on the "Layout" tab
• Choose your desired wrapping style, then click OK to see the text wrap around the

image in the style that you chose.
Autoshapes

• Autoshapes allows you to draw lines, boxes, and other basic shapes within your text
boxes and elsewhere on the page.

• Select Insert > Picture > Autoshapes
• From the menus, select the kind of shape you want to draw
• Find the place where you want to draw the shape, and use click and drag to draw it.

Grouping Objects (Autoshapes and Text Boxes)
• You can group objects together so that when you move or resize one, the other moves or

is resized as well.
• Draw an autoshape that you want to group with a text box.
• Select both of them by holding down the SHIFT key while clicking on each one.
• Right click, then select Group.
• Now, when you move or resize the objects, they are both affected simultaneously.
• You can still edit each object independently (the text in the text box and the autoshape)

Using Word Art
• First Click the WordArt button. The WordArt gallery will appear, allowing you to pick

one of many styles as your starting point.
• The Edit WordArt Text box will appear. Enter your text in the box (you can include line

breaks.) You can also change the font, size and style in this box. When you are
satisfied, click OK.

• The style that you chose will appear on your page. You can move and resize your
WordArt; the options you have in this and the behavior of the different resizing options
will depend on the style of WordArt that you chose.

• A WordArt toolbar will also appear that provides more options for working with your
WordArt.

• Options available to you include:
• Changing the colour of the background and foreground
• Adding shadow effects
• Adding borders
• Turning the WordArt on its side
• Stretching the WordArt to the edges of the frame
• Making the WordArt bold, italic and/or underlined
• Close down the WordArt box when you've finished. Double click the WordArt

if you want to re-edit it.
Add Header/Footers

·
Print Considerations
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• Margins àArrange>Margins
• Orientation àFile>Print Setup
• Always view the "print preview"à File>Print Preview.

• Grayscale button: To see in Black and white print
• Make sure all of the boxes and edges are not hidden or cut off. .

Part III. New Pages and Master Pages
Master pages act as a template for pages in your document. They're useful if you're creating a
multi-page document in which many pages use identical or similar layouts/style; instead of
laying out each page individually, you can create one or more master pages and apply that
formatting to new pages. You can include things like text boxes, page numbers, headers and
footers (things that appear at the top or bottom of every page), margins and guides, page
background/watermarks, images that you want to appear at the same place on each page, and
column guides in your master pages.

• Create a new page by going to Insert > Page.
• To create a master page:

• Select View > Master Pages; the Edit Master Pages pane/sidebar/toolbar will
appear.

• Set up your master page, placing all elements in their proper places.
• To exit out of the Master Pane mode and return to working with your

document's pages, deselect Master View in the View pane or click Close Master
View in the Edit Master View toolbar.

• To apply a master page:
• In the Edit Master Pages task pane, from the Select a master page pull-down list,

select a master page to be applied or select Ignore Master. The selected master
page option is applied to the page.

Personal Information
You can create a personal information set for you, your business, or organization that saves
certain information like name, number, address, logo, and color scheme. This information will be
applied when you create new publications from templates. This can be useful if you have a
certain color scheme that is associated with your organizations name etc.

• Edit>Personal Information>
• If you decide you do not what the color scheme associated with your information than

just click the box.
• You can also customize your color scheme as well

Part IV. Making changes to templates
Sometimes it is easier to make changes to a template and turn that into your master document.
You use the same tools as we have.

• First choose templateàView>toolbars>task pane>new publication
• If you choose Quick Publication Options than your templates are limited to flyers or one

page documents.
• “New Publication” gives you options like “Publications for Print,” “Web Sites and

E-mail,” “Design Sets,” and “Black Publications”
• “Publications for Print”
• “Web Sites and E-mail”
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• “Design Sets”
• “Blank Publications”
•

TechCamp 2006 -1
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